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Introduction

Welcome! This program is a tool designed to aid composers in understanding and analyzing their work as
well as the compositions of others.

Music is an art form which grows and changes over time. Composers often graph their compositions to 
help them better control the pacing and overall arc of a piece. The MusicGraph program is intended as a 
professional tool to produce these graphs automatically, using the MIDI representation of the piece 
produced by most musical notation programs.

More importantly, MusicGraph is intended to help composers explore and control their own compositions. 
Composers who wish to enforce a certain intervallic sonority throughout their composition can use the 
program to double check their compositions. Composers who wish to carefully control the aspects of 
sonority, activity, and volume can how all of these parameters work together in their compositions.

Finally, MusicGraph is also intended to produce beautiful pictures based on solid music theories. These 
pictures can often be intuitively understood by the layperson and used as a guide to understanding the 
composition.
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The Basics

To get started execute the "File / New" pull-down menu command.

This command will prompt you for a MIDI file to graph. Navigate through your file system to the desired 
MIDI file, select it, and then click on OK.

You should now see the "default" graph, a simple graph showing MIDI notes on a solid grey background.

From here you can use the "Format" pull-down menu to modify all aspects of the graph:

Format / Document… Change the size of the graph when it is printed and at normal zoom. 
Specify your document margins.

Format / Axis… Turn on or off the horizontal and vertical axis on your graph. Control how 
many tic marks are displayed and how widely spaced they are.

Format / Background… Set the color of the background (for a fixed, solid background) or choose 
to color the background based on intervallic content.

Format / MIDI… Choose whether or not to display MIDI notes on your graph, and choose 
the colors and sizes of these notes based on note velocity (i.e. volume) 
or MIDI channel (often the same as instrument).

Format / Line Graphs… Turn on or off the various line graphs available:    Volume, Notes-Per-
Second, Intensity, Dissonance, and graphs for each of the intervals 
available in the interval vector.

Format / Decay Times… Change parameters used to compute decay times for notes. Decay times
are used when computing interval vectors and total volume.

Format / Intervals… Choose colors for intervals and change parameters which control how 
the interval vector is computed.

For more information, first execute a menu command. Then, in the parameter window, click on the "?" box
found at the upper-right. You can then click on any parameter or label to get detailed help.
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Interval Vectors

An interval vector is a concise way to specify the interval content in any collection of notes.

For example, a standard C major triad is made up of the notes C, E, and G. Let's look at all possible pairs
of two notes in this triad:

C and E    are a major third (M3) apart
C and G    are a perfect fifth (P5) apart
E and G    are a minor third (m3) apart

So, a major triad is made up of the intervals:    major third, minor third, and perfect fifth. This is the 
"interval content" of the chord. This can be represented with the following vector:

[ 0 , 0 , 1 , 1 , 1 , 0 ]

In an interval vector, each entry stands for a different type of normalized interval:

[ half-step , whole-step , minor-third , major-third , perfect , tritone ]

"Normalized interval" means that inversions and octave displacements are ignored. For example:

half-step =    m2, M7, m9, M14, etc.
whole-step = M2, m7, M9, m14, etc.
minor-third = m3, M6, m10, M13, etc.
major-third = M3, m6, M10, m13, etc.
perfect = P4, P5, P11, P12, etc.
tritone = A4, d5, A11, d12, etc.

Now let's suppose we have a chord made up of the notes C, D, and E (a small diatonic cluster). This 
chord has the following interval content:

C and D    are a whole-step apart
C and E    are a major third apart
D and E    are a whole-step apart

... and therefore it has the following interval vector:

[ 0 , 2 , 0 , 1 , 0 , 0 ]

MusicGraph has some complex rules for generating interval vectors, and provides parameters that you 
can change to control how vectors are computed. Some of these rules are given here:

1) The amount that a pair of notes contributes to an interval vector is based on the strengths of the 
notes. Two very loud notes will contribute more to the interval vector than two soft notes (when 
they are all part of the same chord).

2) A note can contribute to the interval vector even after it is dampened, due to how the note 
reverberates around the room. You can control this parameter (and turn it off) with the 
"Format / Decay Times..." pull-down menu command.

3) Larger intervals contribute less to the interval vector, because the upper note is more likely to be 
in the partial series of the lower note. You can modify this parameter (it is off by default) with the 
"Format / Intervals..." pull-down menu command.

4) MusicGraph attempts to compute a "unison" or "single-note" value for each interval vector. This is
a measure of how much a single note (which could be doubled at the unison or at the octave) 



rises above all of the other notes in the chord. For example, if a chord is made up of C, C, C, E, 
C, and G, then the multiple-C's will tend to overwhelm the interval content of the major triad.

By using these rules, MusicGraph can produce a floating-point, continuously varying interval vector. 
However, since these are all new concepts many of these computations are still very much experimental 
in nature.

To gain more insights into how MusicGraph computes interval vectors, try the "View / Interval Info" pull-
down command (also available as a toolbar button). See the section on "Other Useful Features" for more 
details.
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Other Useful Features

Get a close-up or wide-angle view:    Zoom

Zoom in Use the mouse to select a rectangle inside the window, or
Use the "zoom in" toolbar button ( ), or

Type SHIFT-I, or
Use the View / Zoom In pull-down menu command

Zoom out Click the right mouse button inside the window, or
Use the "zoom out" toolbar button ( ), or
Type SHIFT-O, or
Use the View / Zoom Out pull-down menu command

Reset Zoom (sets the zoom to actual size)
Double-click the left mouse button inside the window, or
Use the "reset zoom" toolbar button ( ), or

Type SHIFT-R, or
Use the View / Reset Zoom pull-down menu command

What is this?    Pop-Up Information

Point the mouse at a MIDI note and a pop-up message will report the note value, volume, starting 
time, length, and decay time of the note.

If interval information is available, then point the mouse anywhere inside the graph and a pop-up 
message will display the normalized interval vector. A normalized vector is where all interval values 
(including the "unison value") add up to 100%.

Interval information will be available if the background is displaying interval content information or if 
any of the line-graphs have been turned on.

Where did these numbers come from?    Interval Info

You can get detailed information on how an interval vector was computed by first selecting "Interval 
Info" from the "View" menu or by clicking on the "Interval Info" toolbar button ( ), and then clicking on
any spot in the graph.

Interval information first displays a list of all the notes currently playing (or reverberating), their start 
times, lengths, decay times, and current volume. Then Interval Info will go through all note pairs, 
identify the interval between the two notes, will identify whether or not the interval is inverted or 
octave-displaced, and will give the final interval value.

Finally, Interval Info will give a chart of all of the interval vectors along with the totals, the normalized 
vector, and wrap up with a few comments on how the algorithms are computed.
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The "To Do" list

Also known as the "don't look for it because it hasn't been programmed yet" list:

· Printing graphs which span multiple pages
· Save, Save As..., Open
· Axis labels

The wish list:

· Save and restore defaults
· Placing multiple MIDI Files on a single page
· A lengthy report of composition-wide statistics: number of notes, average volume, highest and 

lowest note, average interval vector, etc. Also a report of statistics by MIDI channel.
· Option to always place Middle-C in the middle of the graph vertically.
· More controls based on MIDI channel:    the ability to remove a MIDI channel from the graph or 

the interval vector, decay values per MIDI channel, more line controls
· Undo/Redo
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New command (File menu)

All work begins with File/New.

Use File/New to create a new graph. File/New will automatically prompt you to select a MIDI 
file.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

<Not yet implemented>

When implemented, this command will allow you to restore a previously stored graph along 
with all saved formatting parameters.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

<Not yet implemented>



Close command (File menu)

Use this command to close the graph which is currently active (on top). Unfortunately, once 
you close a graph there is no way (at this time) to restore it without restoring all of the 
formatting parameters by hand.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

<Not yet implemented>

When implemented, the Save command will save all graph formatting parameters to a file so
they can be restored at a later time.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

<Not yet implemented>

When implemented, the Save As command will save all graph formatting parameters to a 
file so they can be restored at a later time.



 1, 2, 3, 4 command (File menu)

<Not yet implemented>

When implemented, this command will allow you to open one of the last four documents 
that you closed.



Exit command (File menu)

Use this command to end your MusicGraph session.    You can also use the Close command 
on the application Control menu. 

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

<Not yet implemented>

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<Not yet implemented>



Cut command (Edit menu)

<Not yet implemented>

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

<Not yet implemented>

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

<Not yet implemented>

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in MusicGraph, such as Zoom In, Zoom Out, Reset Zoom, and 
Interval Information.    A check mark appears next to the menu item when the Toolbar is 
displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in MusicGraph.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    <Not yet implemented>

<Not yet implemented>    Save the active document or template with its current 
name.    

Print the active document.

Display context-sensitive help. Click here and then click on the toolbar button, 
window control, or pull-down menu command about which you would like more help.

Zoom in your graph (make it larger).

Zoom out your graph (make it smaller)

Reset the zoom to 100% (actual size as specified in the Format / Document... 
properties.

Request interval information. Click here and then click anywhere within your graph to
get detailed information on how the interval vector was computed.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the MusicGraph document window.    To display 
or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description

CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

<Not yet implemented fully>

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

MusicGraph displays a list of currently open document windows at the bottom of the Window
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using MusicGraph and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
MusicGraph.



Context Help command 

Use the Context Help command to obtain help on some portion of MusicGraph.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the MusicGraph window, such as another Toolbar 
button or pull-down menu.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the file name of the MIDI file 
you are currently working with.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the MusicGraph window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    MusicGraph determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    MusicGraph 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>





To get detailed help on the parameters in this dialog box, click on the question-mark at the 
upper right of the box and then click on any parameter.



Specifies the width of the graph (in inches or centimeters per minute of music) when printed or displayed at normal 
zoom. Put double quotes (") or ‘cm’ after the number to specify inches or centimeters.



These parameters specify the physical dimensions of the graph when printed or displayed at normal zoom.



Specifies the total height of the graph (in inches or centimeters). The graph is scaled so that the lowest note is at the 
bottom of the graph and the highest is at the top. Put double quotes (") or ‘cm’ after the number to specify inches or 
centimeters.



The total time of the music is shown in minutes and seconds, to help you specify the correct value for the horizontal 
scale.



Will automatically set the horizontal scale so that the graph expands to fit the whole width of the printed page.



These parameters specify the size of the margins used when printing the graph.



The size of the margin to leave empty at the top of the page. Put double quotes (") or ‘cm’ after the number to 
specify inches or centimeters.



The size of the margin to leave empty at the bottom of the page. Put double quotes (") or ‘cm’ after the number to 
specify inches or centimeters.



The size of the margin to leave empty on the left side of the page. Put double quotes (") or ‘cm’ after the number to 
specify inches or centimeters.



The size of the margin to leave empty on the right side of the page. Put double quotes (") or ‘cm’ after the number to
specify inches or centimeters.



The dimensions (height, width, and orientation) of the currently selected paper onto which the graph would be 
printed. Click on "Page Setup" to change these dimensions.



Displays the “Print Setup…” window to change your printer settings, including the current page dimensions and 
orientation.



The physical dimensions of the currently selected paper, including the margins. Click on "Page Setup" to change 
these dimensions.



The dimensions of the currently selected paper, minus the dimensions. This is the amount of space which is 
available for printing your Music Graph. Click on "Page Setup" to change these dimensions.



When enabled, a horizontal axis marking time will be displayed at the bottom of your graph.



Will enable large tic marks along the horizontal axis, typically used to mark every minute of music.



The distance between each large tic mark on the horizontal axis, specified in minutes and seconds of real time.



Check this box to print labels (in MM:SS format) next to each large tic mark.



Will enable small tic marks along the horizontal axis, typically used to mark every 15 seconds of music or less.



The distance between each small tic mark on the horizontal axis, specified in minutes and seconds of real time.



When enabled, a vertical axis marking octaves and half-steps will be displayed at the left of your graph. The axis is 
really only pertinent for the display of MIDI notes.



Will enable large tic marks along the vertical axis, typically used to mark every octave along the chromatic scale.



The distance between each large tic mark on the vertical axis, specified as a number of half-steps. Use 12 half-steps 
to put a tic every octave. A large tic mark will always be placed on Middle-C.



Check this box to print labels (such as "Middle-C" or "G3#") next to each large tic mark.



Will enable small tic marks along the vertical axis, typically used to mark every minor or major 3rd of music.



The distance between each small tic mark on the vertical axis, specified in half-steps of the chromatic scale.



When selected, the background of the graph will be painted with a fixed, solid color.



Click here to change the color of the background, when a fixed background is selected.



When selected, the background will be painted with a graphic which represents the interval content of the 
composition at each point in time. Use the "Format/Intervals…" and the "Format/Decay Times…" options to change
interval colors and algorithmic parameters.



Specifies how the various interval colors (based on the intervallic content of the composition at each point in time) 
will be blended together when creating the background graphic. Use the "Format/Intervals…" menu command to 
change the basic interval colors.



When interval colors are blended by one of the "Graph" algorithms, colors are placed one on top of the other. These 
selections allow you to change the order in which the colors are graphed, from smallest to largest (i.e. a minor-2nd 
to a tritone) or from largest to smallest (tritone to minor-2nd).



Use this window to specify how the background of the graph will be painted, either a single fixed color or based on 
interval content.



Use this dialog to display MIDI data (notes, tempo changes) on your Music Graph.



When enabled, a "piano roll" display of MIDI notes will be displayed on your graph. Each note will be represented 
by a line, starting and ending in time when the actual note starts and is released.



MIDI notes are drawn with horizontal lines on your graph. Use this option to choose how these lines will be capped 
at the ends:    "Square" - lines will have square caps which extend beyond the line, "Round" - lines will have round 
caps which extend beyond the lines, and "Flat" - lines will end sharply with no cap at all (a more accurate but less 
graphically pleasing representation).



Use the "Line Width" parameters to make MIDI lines thicker for notes with higher velocities (i.e. louder volumes). 
The line width will be scaled smoothly from the "ppp" value to the "FFF" value based on the velocity of the note (0 
to 100%). The width of the line is specified in portions of a half-step. So a number greater than 1.0 will potentially 
overwrite notes a half-step higher or lower. Large numbers (such as 3.0) often look graphically pleasing.



When selected, MIDI lines will be given a color which can change based on the velocity (i.e. volume) of the note. 
The color will be blended smoothly from the "ppp" value to the "FFF" value. If both colors are the same, all MIDI 
lines will be the same color.



Click in the box to specify what color will be displayed for MIDI notes that are very soft.



Click in the box to specify what color will be displayed for MIDI notes that are very loud.



Click in these boxes to select a color for notes that are transmitted over a specific MIDI channel (0 to 15). You will 
only be able to specify colors for MIDI channels which actually exist in your file.



When selected, the color of each note will be based on the MIDI Channel assigned to the note (0-15), as specified in 
the MIDI file. Typically, different channels are assigned to different instruments, so this is a way that notes from 
different instruments can have different colors.



When selected, tempo changes specified in your MIDI File will be displayed as vertical lines on the graph. Currently
this option is not very useful, and is primarily used for debugging.



Use this dialog box to enable graphs of your music and to set the properties for how they will be drawn. These "line-
drawn graphs" show how various properties of your music (such as volume, dissonance, intensity, or interval 
content) change over the course of the work.



When selected, this option will graph "total volume" across your piece. "Total volume" is simply the sum of all 
notes which are playing (or reverberating) at each point in time. Use the "Format/Decay Times…" menu command 
to specify how notes decay over time after they are released.



Click in the box to specify the color that will be used to draw the graph of total volume.



Each note is given a volume level from 0 to 100% based on it's MIDI velocity (from 0 to 255). At every point in 
time, these levels are simply added together to compute the total volume. Therefore, if you have ten notes playing, 
you could have a total volume of 1000%. Use this box to specify the maximum number of notes which could be 
playing at full volume all at once. Remember that notes which are decaying are also included in the total volume 
computation (use the "Format/Decay Times…" dialog to control decay times of notes).



When selected, this option will graph "notes-per-second" across your piece. At each point in time, the program will 
count up all of the notes which started in the previous second and this number will be plotted. The purpose of this 
graph is to give an idea of the total activity in your composition.



Click in the box to specify the color that will be used to draw the graph notes per second.



Use this box to specify the maximum number of notes-per-second which you expect to have in your composition. 
This number will be used to scale the graph of notes-per-second so that it fits on the graph.



When selected, this option will graph "Overall Intensity" across your music. This graph is intended to be a good 
overall graph of your work, assuming that high-points in music are generally those which are loudest, most 
dissonant, and most active (i.e. most notes per second). This graph is a work-in-progress.



The three weighting factors below are used in a weighted average of Volume, Notes Per Second, and Dissonance. 
Note that it is the *difference* in these three numbers which is important. If all three numbers are the same (no 
matter how large they are) then all factors will be equally weighted. If, for example, you want Dissonance to count 
twice as much as Notes-Per-Second, then make the Dissonance factor twice as large as the Notes-Per-Second factor.



Enter into this box the relative weight of "Total Volume" as it contributes to "Intensity". If this number is much 
larger than the others, then volume will count for a lot. If it is smaller than the others, then volume will be less 
important.



Enter into this box the relative weight of "Notes-Per-Second" as it contributes to "Intensity". If this number is much 
larger than the others, then Notes-Per-Second will count for a lot. If it is smaller than the others, then Notes-Per-
Second will be less important.



Enter into this box the relative weight of "Dissonance" as it contributes to "Intensity". If this number is much larger 
than the others, then Dissonance will count for a lot. If it is smaller than the others, then Dissonance will be less 
important.



Click in the box to specify the color that will be used to graph Intensity across your music.



Click here to graph the level of dissonance throughout your music. In this case, dissonance is assumed to be based 
on the intervallic content of the notes in your work. You can choose the relative weighting of the intervals in your 
composition by entering numbers in the boxes below.



Click in the box to specify the color that will be used to graph the dissonance level.



Use these boxes to enter a weight for each interval to specify how "dissonant" the interval is relative to all of the 
other intervals. These numbers are relative to each other, so if all numbers are the same then all intervals are counted
equally, regardless of how large the number is. If you want one interval (minor-2nd, say) to count twice as much as 
all the others, then make it twice as large as all the others.



Place check marks in these boxes to graph each interval individually. Sometimes these graphs are more useful than 
the background interval-content graphs because all intervals are plotted from the same baseline, and so it is easier to 
tell when one type of interval predominates over the others. To specify the color of each line, use 
"Format/Intervals…".



Check this box to plot dots at each point rather than a long, connected line. If the interval content of your work 
varies widely and quickly, then showing dots instead of lines will often be less messy to plot.



Enter here the width of the dots to be plotted for each interval. Enter a number followed by a double quote (") for 
inches or 'cm' for centimeters.



Enter here the width of the lines used to plot the graphs of Volume, Notes-Per-Second, Intensity, and Dissonance. 
Enter a number followed by a double quote (") for inches or 'cm' for centimeters.



Use this dialog to specify how notes decay over time. Decay times are used when computing interval vectors and 
total volume (which are in turn used to compute dissonance and intensity). Also, you can use decay times to 
"smooth" the graphs, especially if you put a larger number (like 1.0 or 2.0) in the "After the note" decay box.



Decay times are computed using a "half-life" exponential decay, like in nuclear physics. All this means is that the 
volume of a note drops off very quickly at first, and then more slowly as the note continues to reverberate. For 
example, suppose a note starts off at the maximum volume (100%) and has a half-life decay time of "1.0". This 
mean that after 1 second the volume will drop to 50%, after 2 seconds the volume drops to 25%, after three seconds 
it's 12.5%, and so on. When a note reaches 1% of the maximum volume, then it is cut off.



If you have instruments that decay quickly even while sustained (for example, harpsichord, guitar, lute, pizzicato 
strings, etc) then enter a small number (such as 0.2 to 0.5) in this box. If you have an instrument which does not drop
in volume at all (e.g. bowed strings, woodwinds, etc.) or you wish to effectively remove the during-the-note decay-
time computations from your graphs then enter a large number (such as 999.0).

To understand "half-life decay time", suppose a note starts off at the maximum volume (100%) and has a half-life 
decay time of "1.0". This mean that after 1 second the volume will drop to 50%, after 2 seconds the volume drops to 
25%, after three seconds it's 12.5%, and so on. When a note reaches 1% of the maximum volume, then it is cut off.



Use this parameter to specify how much a note reverberates after it is played. A large number (such as 1.0) indicates 
a long reverberation time, and a small number (such as 0.1) indicates a relatively dry hall. You can also use this 
number to "smooth" your graphs. Larger values will give you smoother graphs for interval content and total volume,
but may also muddy the picture somewhat.

To understand "half-life decay time", suppose a note starts off at the maximum volume (100%) and has a half-life 
decay time of "1.0". This mean that after 1 second the volume will drop to 50%, after 2 seconds the volume drops to 
25%, after three seconds it's 12.5%, and so on. When a note reaches 1% of the maximum volume, then it is cut off.



This is an experimental parameter which is intended to increase the impact of long-held notes. A value of 1.0 means 
that long notes are *not* given special consideration. Larger values in this box (such as 2.0, or 3.0) will lengthen the
decay times of notes which are as long as the longest notes in the piece.



Click on this check box to show the decay times for each note on your graph. You can use this option to check how 
the decay times "look" before they are used in interval and total volume calculations.



Click on the boxes to choose a color for each type of interval. These colors will be used when painting the 
background based on interval content (see the "Format/Background…" menu command) and when plotting interval 
line-graphs (see the "Format/Line Graphs…" menu command).



These are two experimental parameters intended to weaken the contribution of intervals which are inverted or 
widely spaced. Set these parameters to 1.0 if you do *not* want them to have any effect, or to a small number such 
as 0.2 if you want them to have a very pronounced effect.

The idea here is that larger intervals contribute less to the total interval vector, because, speaking theoretically, larger
intervals are more likely to be found in the overtone series anyway. For example, if you have a major third plus two 
octaves, then the upper note is already a partial of the lower note, and so the "major-third-ness" of the interval is not 
as pronounced.



Specify 1.0 if you want inverted intervals (i.e. M7, m7, M6, m6, and P5 intervals) to be treated just like any other 
interval. Use a smaller number (like 0.8) if you want these intervals to contribute less to the interval vector.



Specify 1.0 if you want intervals greater than an octave to be treated just like any other interval. Use a smaller 
number (like 0.5) if you want these intervals to contribute less to the interval vector. Note that this number is applied
for each octave. For example, if your octave factor is 0.5, then an interval which is greater than an octave is reduced 
by 50%, an interval greater than two octaves is reduced by 75%, an interval greater than three octaves is reduced by 
87.5%, and so on.









Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




